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COPA Apprentice (AITT 109th Question Paper MCQ) 
 
1. CMS in web content stands for _______. 
a) Content Management System 
b) Content Maintenance System 
c) Content Management Symbol 
d) Client Management System 
Ans. a 
 
2. A compiler converts source code to ______ code. 
a) executable machine code 
b) source code 
c) mnemonic code 
d) key code 
Ans. a 
 
3. ______ is the name for online description of a product. 
a) Online catalogue 
b) Offline catalogue 
c) Printed catalogue 
d) Handwritten catalogue 
Ans. a 
 
4. What is correct about accounting for monetary transactions? 
a) Recording 
b) Tallying 
c) Verification 
d) All of these 
Ans. d 
 
5. Which card cannot be used for cash withdrawal? 
a) ATM card 
b) Charge 
c) Debit card 
d) credit card 
Ans. b 
 
6. Example of an online marketplace is/are:- 
a) eBay 
b) Flipkart 
c) Snapdeal 
d) All of these 
Ans. d 
 
7. E-Commerce may be carried out using _____ modes. 
a) SMS or phone conversation 
b) Web 
c) email 
d) All of these 
Ans. d 
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8. The default period of loan for a credit card holder is ____ days.  
a) 55 
b) 56 
c) 57 
d) 58 
Ans. a 
 
9. Which of the following is a common Payment Gateway used for online transactions? 
a) CCAvenue 
b) BillDesk 
c) PaySeal 
d) All of these 
Ans. d 
 
10. The _____ operator returns 1 if at least one of the bits is 1. 
a) OR 
b) NOT 
c) XOR 
d) AND 
Ans. a 
 
11. The main advantage of computer is: 
a) speed 
b) large storage capacity 
c) creating programs for new jobs 
d) All of these 
Ans. d 
 
12. ______ function in VBA Creates a custom error message. 
a) CVErr 
b) InputBox 
c) MsgBox 
d) Format 
Ans. a 
 
13. The input to _____ is called source program. 
a) Assembler 
b) Compiler 
c) Translitor 
d) Decoder 
Ans. a 
 
14. In Tally, which key is used for purchase voucher? 
a) F9  b) F10  c) F4  d) F8 
Ans. a 
 
15. A function begins with ____ keyword. 
a) Function  b) return 
c) first   d) End function 
Ans. a 
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16. VBA IDE में प्रॉपर्टी विंडो को कैसे प्रदर्शित ककया जा सकता है ? 
a) Choosing view > properties 
b) Pressing Alt+V+W 
c) Pressing F4 
d) All of these 
Ans. d 
 
17. VBA has a coding, compilation, running and debugging environment called _____. 
a) Integrated Development Environment (IDE) 
b) Editor 
c) Highlighter 
d) Compiler 
Ans. a 
 
18. RAD in the design application stands for _______. 
a) Rapid Application Development 
b) Real Application Development 
c) Rapid Analysis Development 
d) Ready Application Development 
Ans. a 
 
19. IDE stands for _____ 
a) Integrated Development Environment 
b) Internal Development Environment 
c) Integrated Design Environment 
d) Integrated Drafting Environment 
Ans. a 
 
20. ______ is the shortcut to display properties window in VBA IDE. 
a) F4  b) F5  c) F2  d) F1 
Ans. a 
 
21. MS Excel creates ______ to execute VBA code. 
a) virtual machine  
b) real time computer 
c) mobile computer  
d) tablet computer 
Ans. a 
 
22. OpenOffice.org text document file has extension of ______. 
a) .odt  b) .ods  c) .odg  d) .odp 
Ans. a 
 
23. Boolean data type in VBA has size of _______. 
a) 2 bytes 
b) 1 byte 
c) 4 bytes 
d) 3 bytes 
Ans. a 
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24. _______ function in VBA returns today’s date.  
a) Date 
b) DATEIFF 
c) DATEADD 
d) DATEPART 
Ans. a 
 
25. _______ function in VBA returns current time. 
a) NOW 
b) TIMEVALUE 
c) TIMESERIAL 
d) WEEKDAY 
Ans. a 
 
26. The ______ operator in VBA returns 1 only if both bits are 1. 
a) AND  b) OR  c) NOT  d) XOR 
Ans. a 
 
27. Which of the following loop is available in VBA? 
a) For and While 
b) Do While and Do until 
c) For each 
d) All of these 
Ans. a 
 
28. ______ function in VBA displays a message box. 
a) MsgBox b) Box  c) Message d) InputBox 
Ans. a 
 
29. VBA permits _____ of data from spreadsheets. 
a) reading 
b) writing  
c) both reading and writing 
d) neither reading nor writing 
Ans. c 
 
30. A function ends with _______ statement. 
a) End function 
b) Function 
c) return 
d) End 
Ans. a 
 
31. VBA supports ______ keyword for access control. 
a) Private 
b) Public 
c) Both Private and Public 
d) Neither Private nor public 
Ans. c 
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32. Which of the following accounting types is supported by Tally? 
a) Cash 
b) inventory 
c) payroll 
d) All of these 
Ans. d 
 
33. What is correct about accounting for monetary transactions? 
a) Recording 
b) Tallying 
c) Verification 
d) All of these 
Ans. d 
 
34. ______ account debits the receiver and credits the giver. 
a) Personal 
b) Nominal 
c) Verification 
d) Real 
ans. a 
 
35. In PowerPoint, table can be inserted using ______ menu. 
a) Insert > Tables 
b) Insert > Images 
c) Insert > Illustrations 
d) Insert > Links 
Ans. a 
 

36. खाता िीर्ट के पहले 4 कॉलम का उपयोग _____ ररकॉर्डडग के ललए ककया जाता है | 
a) Debit 
b) Credit 
c) Income 
d) Expense 
Ans. a 
 
37. Accounting transactions are related to which of the following? 
a) Income/expense 
b) Asset/liability 
c) Inventory 
d) All of these 
Ans. d 
 
38. The method of recording debit and credit sides separated by a line is nicknamed as ______ 
accounting. 
a) T 
b) U 
c) V 
d) W 
Ans. a 
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39. _____ account debits expense and credits the income. 
a) Nominal  
b) Personal 
c) Real 
d) Verification 
Ans. a 
 
40. Purchase, storage and disposal of stock is called _____ management. 
a) Stock 
b) Account 
c) Reorder 
d) Cash 
Ans. a 
 
41. VAT stands for _____ in taxation. 
a) Value added tax  
b) Value amount tax 
c) Visual Added tax 
d) Value asset tax 
Ans. a 
 
42. In Powerpoint, drawing for use in the presentation may be created using _____ menu. 
a) Home > Drawing 
b) Home > Font 
c) Home > Slide 
d) Home > Paragraph 
Ans. a 
 
43. Tally can provide ______ to each company. 
a) Password security 
b) no security 
c) barrier 
d) wrapper 
Ans. a 
 
44. ____ is the shortcut to set date in Tally. 
a) F6 b) F4 c) F5 d) F2 
Ans. d 
 
45. Which of the following is a current asset? 
a) Cash 
b) Inventories 
c) Receivables 
d) All of these 
Ans. d 
 
46. In Tally, which key is used for purchase voucher? 
a) F9  b) F10  c) F4  d) F8 
Ans. a 
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47. In Double entry, income is always _____. 
a) Credited 
b) Increased 
c) Debited 
d) Not changed 
Ans. a 
 
48. Which parties are involved in electronic billing? 
a) Billers 
b) Bankers 
c) Consolidators 
d) All of these 
Ans. d 
 
49. A set of instructions is called _____. 
a) Program 
b) Software 
c) Sequence 
d) Programming language 
Ans. a 
 
50. In Ms Word, mail merge result may be printed using ______ menu. 
a) Mailing > Print documents 
b) Mailing > Edit Individual Documents 
c) Mailing > Preview Results (Alt + M + P) 
d) Mailing > Send E-Mail Messages 
Ans. a 
 
51. When windows loads during installation, ____ is to be chosen first. 
a) keyboard layout  
b) language selection for installation 
c) keyboard layout and language selection for installation both 
d) RAM 
Ans. c 
 
52. A CPU holds the instruction in _______. 
a) Instruction register 
b) Index register  
c) Program counter 
d) Entry register 
Ans. a 
 
53. The input to _______ is called source program. 
a) Assembler 
b) Compiler 
c) Translator 
d) Decoder 
Ans. a 
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54. Process of turning off of a computer is called ____. 
a) Cold booting 
b) Warm booting 
c) Shutdown 
d) Swiching 
Ans. c 
 
55. In MS Word, choosing number of columns per page in possible through ___. 
a) Page Layout > Columns 
b) Page Layout > Page setup (Alt + P + SP) 
c) Page Layout > Water mark 
d) Page layout > Page color 
Ans. a 
 
56. What is the logo used for LINUX? 
a) Tux 
b) Debian 
c) Linux trobalds 
d) None of these 
Ans. a 
 
57. To be able to change the directory, you need ______. 
a) Execute permission 
b) Read permission 
c) Write permission 
d) None of these 
Ans. a 
 
58. In MS Word, selecting page size, margins and paper orientation is possible through ______. 
a) Page layout > page setup (Alt + P + SP) 
b) Page layout > Water Mark  
c) Page layot > Page color 
d) Page layout > columns 
Ans. a 
 
59. ROM stands for:- 
a) Read Only Memory 
b) Random Ordinary Memory 
c) Read Ordinary memory 
d) Read Only Mail 
Ans. a 
 
60. Primary boot process is also called _____. 
a) Loading of operating system 
b) Installation  
c) Formatting 
d) Post 
Ans. a 
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61. In booting of computer, POST is expanded as:- 
a) Power On self Test 
b) Disk Defragmenting 
c) Formatting 
d) Scandisk 
Ans. a 
 
62. Full form of BIOS:- 
a) Basic Input Output System 
b) Bare Input Output System 
c) Basic Intermediate Operating System 
d) Banned Input Output System 
Ans. a 
 

63. एक अच्छी तरह से लडफाइंड डेर्टाबेस में, डेर्टाबेस, रे्टबल और कॉलम के नाम में स्पेस ______ | 

a) होता ह ै 

b) हो सकता ह ै 

c) नहीं होना चालहए  

d) होना चालहए  

उत्तर – c  

 

64. MySQL, is the _______ database management tool. 
a) Professional 
b) Open source 
c) Outdated 
d) Unsuitable 
Ans. b 
 
65. New database created in MS Access has got a default table named ______. 
a) Table1 
b) Database1 
c) Column1 
d) Row1 
Ans. a 
 
66. Inserting data and modifying values in previously inserted data in tables of a database is called 
______. 
a) data update 
b) data retrieval 
c) data definition 
d) database administration 
Ans. a 
 
67. Querying and selecting data from a table is called _____. 
a) data retrieval 
b) data definition 
c) database administration 
d) data update 
Ans. a 
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68. Defining the users, passwords and roles for users to control a database is called _____. 
a) database administration 
b) data update 
c) data retrieval 
d) data definition 
Ans. a 
 
69. Relational database model was proposed by ______. 
a) Edgar F. Codd 
b) Bill Gates 
c) Steve Jobs 
d) Dennis Ritchie 
Ans. a 
 
70. ODMG stands for ______. 
a) Object Data Management Group 
b) Object Digital Management Group 
c) Object Data Maintenance Group 
d) Object Data management General 
Ans. a 
 
71. Object oriented databases are based on the concept of ______, similar to object oriented 
programming. 
a) objects 
b) table 
c) column 
d) SQL 
Ans. a 
 
72. A key which is unique to a table is called _____. 
a) Primary key 
b) Unique 
c) Foreign key 
d) Master key 
Ans. a 
 
73. In MS Access, a macro can be activated by pressing _____ button. 
a) Run 
b) Form 
c) Table 
d) Report 
Ans. a 
 
74. SQL stands for _____. 
a) Structured Query language 
b) Simplified Query Language 
c) Structured Question language 
d) Synchronized Query Language 
Ans. a 
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75. DBMS stands for _____. 
a) Database Management System 
b) Database Management Syntax 
c) Database Managecent System 
d) Digital Management Systam 
Ans. a 
 
76. _____ is used to quickly retrieve information from a database. 
a) Index 
b) View 
c) Table 
d) Queue 
Ans. a 
 
77. Which of the following data type is used to perform mathematical calculations? 
a) Numeric 
b) Alphabetic 
c) Character 
d) None of these 
Ans. a 
 
78. A field that have only two values True/False is _____. 
a) Yes/No 
b) Numeric 
c) Auto number 
d) Zero number 
Ans. a 
 
79. Which variable can be defined everywhere in your code? 
a) Global 
b) Local 
c) Script 
d) General 
Ans. a 
 
80. _____ refers to collection, storage, manipulation, reporting and mining of available information.  
a) Database management 
b) Presentation  
c) Charting 
d) Document preparation 
Ans. a 
 
81. Oracle, SAP HANA, MySQL and SQLite are the most popular _____ tools. 
a) database management 
b) image editing 
c) document typesetting 
d) graphics & animation 
Ans. a 
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82. Wordpress need to be copied to ______ to start creating a website. 
a) root directory of the web server 
b) Downloads  
c) Pictures 
d) Documents 
Ans. a 
 
83. SSL stands for _____. 
a) Secure Socket Layer 
b) Secure Searching Layer 
c) Second Socket Layer 
d) Secure Socket link 
Ans. a 
 
84. Joomla is a Content Management System based on scripting language _____. 
a) PHP 
b) Python 
c) Ruby 
d) Perl 
Ans. a 
 
85. CMS in web content stands for _____.  
a) Content Management system 
b) Content Maintenance System 
c) Content Management Symbol 
d) Client Management System 
Ans. a 
 
86. Wordpress, Apache Roller, OpenCMS, Dot CMS, Drupal, etc. are some of the _____ software 
packages. 
a) open source 
b) Professional  
c) escrow source 
d) restricted 
Ans. a 
 
87. Frontpage is a tool for _____. 
a) web page creation 
b) web page editing 
c) both web page creating and web page editing 
d) neither web page creation nor web page editing 
Ans. c 
 
88. DHTML stands for _____. 
a) Dynamic Hyper Text Markup Language 
b) Dynamic Hyper Text Machine Language 
c) Drastic Hyper Text Markup Language 
d) Dynamic Higher Text Markup language 
Ans. a 
 



These Questions Prepared by: SONU (HEETSON) 
 
89. KompoZer is a ____ tool. 
a) web page creation 
b) web page editing  
c) both web page creation and web page editing 
d) neither web page creation nor web page editing 
Ans. c 
 
90. Port number _____ handles HTTP communications. 
a) 80 
b) 443 
c) 25 
d) 20 
Ans. a 
 
91. DOM stands for _____. 
a) Document Object Model 
b) Different Object Model 
c) Dynamic Object Model 
d) Document Offset Model 
Ans. a 
 
92. Scripting languages like Javascript, VBScript, etc. executed by a browser are called _____ side scripts. 
a) client 
b) server  
c) way 
d) unrelated 
Ans. a 
 
93. The command to invoke power point from command line is _____. 
a) powerpnt 
b) power 
c) point 
d) msppt 
Ans. a 
 
94. In Powerpoint, font for presentation may be chosen from ____ menu. 
a) Design > Themes 
b) Home > Font 
c) Home > Slides 
d) Home > Paragraph 
Ans. b 
 
95. Which of the following is an important property of images? 
a) Colour 
b) Width 
c) Height 
d) All of these 
Ans. d 
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96. TIFF is more suitable for ______ than for digital photography. 
a) Digital printing 
b) Digital drawing 
c) Digital video 
d) Digital audio 
Ans. a 
 
97. The client of a web server uses for display of the page _____. 
a) web browser 
b) word processor 
c) spreadsheet 
d) power point 
Ans. a 
 
98. CSS in web scripting stands for ______. 
a) Cascading Style sheet 
b) Cascading system sheet 
c) Crisp Style sheet 
d) Cascading Style Set 
Ans. a 
 
99. Web pages are designed primarily in ______. 
a) HTML 
b) Basic 
c) C ++ 
d) Fortran 
Ans. a 
 
100. The software used for viewing web pages is called _____. 
a) Browser 
b) Word Processor 
c) Spreadsheet 
d) Power point 
Ans. a 
 
101. Web pages which interact with user are called _____HTML pages. 
a) dynamic 
b) internal 
c) external 
d) static 
Ans. a 
 
102. W3C (the international body for web standards) stands for _____. 
a) world wide web consortium 
b) world wide water consortium 
c) write wide web consortium 
d) world wide web condition 
Ans. a 
 
 



These Questions Prepared by: SONU (HEETSON) 
 
103. The portion of script code (written in Javascript/VBscript) executed inside a browser is called _____ 
side scripting. 
a) client 
b) right 
c) left 
d) server 
Ans. a 
 
104. CMOS is a type of _____. 
a) RAM 
b) ROM 
c) DVD 
d) CD 
Ans. a 
 
105. The third generation of computers used _____. 
a) Integrated Circuits 
b) Transistors  
c) Vaccum Tubes 
d) Microprocessor 
Ans. a 
 
106. The fourth generation of computers used _____. 
a) Vacuum Tubes 
b) Transistors 
c) Integrated Circuits 
d) Microprocessor 
Ans. d 
 
107. The longest/largest button on keyboard is _____. 
a) space bar 
b) enter 
c) backspace 
d) tab 
Ans. a 
 
108. TFT is expanded as _____. 
a) Thin Film transistor 
b) Technology film Transistor 
c) Technology Film Transmission 
d) Technology Ferm Transistor 
Ans. a 
 
109. Mechanical calculator was invented by ______. 
a) John Napier 
b) Edmund Gunter 
c) Blaise Pascal 
d) Charles Babbage 
Ans. c 
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110. The _____ keys can move the cursor up, down, left or right. 
a) num lock 
b) arrow 
c) scroll lock 
d) Esc 
Ans. b 
 
111. Which device is a combination of magnetic and paper media? 
a) MICR 
b) OCR 
c) MCR 
d) None of these 
Ans. a 
 
112. What is the full form of GIF? 
a) Graphics interchange format 
b) Graphics international format 
c) Group of international Friends 
d) Graphics Indian format 
Ans. a 
 
113. PNG in digital imaging stands for _____. 
a) Portable Network Graphics 
b) Portable Number Graphics 
c) Portable Network Grayscale 
d) Palate Network Graphics 
Ans. a 
 
114. It is a feature to remove selected text or graphics from a document:- 
a) Cut 
b) Delete 
c) Remove 
d)  All of these 
Ans. d 
 
115. A clipboard is a temporary storage used to store _____. 
a) Cut/Copy data 
b) Files 
c) Folders 
d) Videos 
Ans. a 
 
116. Computer servers are used in which of the following field? 
a) Tracking of consignments 
b) Online reservation of tickets 
c) E-commerce 
d) all of these 
Ans. d 
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117. Computer networks in the form of LAN, WAN, MAN and the Internet help in:- 
a) Transactions of information 
b) Sharing of information 
c) Transactions of e-commerce 
d) All of these 
Ans. d 
 
118. The main advantage of computer is:- 
a) speed 
b) large storage capacity 
c) creating programs for new jobs 
d) All of these 
Ans. d 
 
119. A collection of computers used for online data storage through the Internet is called:- 
a) Cloud computer 
b) Main frame computer 
c) Micro computer 
d) Laptop 
Ans. a 
 
120. Which of the following is present in a computer? 
a) Input unit 
b) Central Processing Unit (CPU) 
c) Output unit 
d) All of these 
Ans. d 
 
121. Keyboard, mouse, scanner, stylus, light pen, etc. are classified under ______. 
a) Input unit 
b) Central processing unit (CPU) 
c) output unit 
d) Software 
Ans. a 
 
122. Monitor (VDU), printer, plotter, etc. are classified under _____. 
a) output unit 
b) input unit 
c) central processing unit (CPU) 
d) software 
Ans. a 
 
123. Graphical representation of the flow of program is called _____. 
a) Flowchart 
b) Source code 
c) algorithm  
d) Executable code 
Ans. a 
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124. The standard interfaces provided by a browser for interaction with program script is called _____. 
a) Browser Object Model 
b) Browser Opening Model 
c) Brown Object Model 
d) Browser Object Mission 
Ans. a 
 
125. The sequence of steps taken to solve a problem is called ____. 
a) algorithm 
b) explanation 
c) steps 
d) item 
Ans. a 
 
126. The circle symbol denotes ____ operation in flowchart. 
a) Continuation/Connector 
b) source code 
c) output/input 
d) start/end 
Ans. a 
 
127. The oval symbol denotes ______ operation in flowchart. 
a) start/end 
b) continuation/connector 
c) input/output 
d) flow direction 
Ans. a 
 
128. Special characters are otherwise called ______. 
a) escape sequences 
b) invalid characters 
c) wrong characters 
d) constants  
Ans. a 
 
129. ______ denotes backspace in Javascript. 
a) b 
b) t 
c) n 
d) v 
Ans. a 
 
130. ______ function in Javascript returns length of a string. 
a) length() 
b) charCodeAt() 
c) charAt() 
d) concat() 
Ans. a 
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131. _____ denotes the bitwise AND operator in Javascript. 
a) & 
b) ! 
c) ~ 
d) ^ 
Ans. a 
 
132. ______ denotes the bitwise NOT operator in Javascript. 
a) ~ 
b) & 
c) ! 
d) ^ 
Ans. a 
 
133. In JavaScript _____ keyword denotes beginning of a function. 
a) function 
b) break 
c) label 
d) continue 
Ans. a 
 
134. BOM stands for ____. 
a) Browser Object Model 
b) Browser Opening Model 
c) Brown Object Model 
d) Browser Object Mission 
Ans. a 
 
135. Which of the following actions MS Excel can do for a given data? 
a) Sort 
b) Statistically 
c) Draw graphs 
d) All of these 
Ans. d 
 
136. In MS Excel, the common type of data applicable to any cell is called ___. 
a) General 
b) Number 
c) Currency 
d) Text 
Ans. a 
 
137. The formula =A5*5 is written in _____ system. 
a) static 
b) semi-relative 
c) relative 
d) unstatic 
Ans. c 
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138. _____ is the keyboard shortcut for paste operation. 
a) Ctrl + X 
b) Ctrl + V 
c) Ctrl + C 
d) Ctrl + K 
Ans. b 
 
139. Which of the following keys are used to create the new document? 
a) Ctrl + N 
b) Ctrl + O 
c) Ctrl + S 
d) Ctrl + V 
Ans. a 
 
140. In OpenOffice.org, spreadsheet can be prepared using ______ application. 
a) calc 
b) writer 
c) draw 
d) impress 
Ans. a 
 
141. The vertical orientation of page layout is known as ______. 
a) Portrait 
b) Landscape 
c) Header 
d) Footer 
Ans. a 
 
142. Which bar displays the name of the document and program? 
a) Title bar 
b) Tool bar 
c) Menu bar 
d) All of these 
Ans. a 
 
143. ______ is the keyboard shortcut for cut operation. 
a) Ctrl + X 
b) Ctrl + V 
c) Ctrl + C 
d) Ctrl + K 
Ans. a 
 
144. Using chart wizard, you can quickly and easily turn your _______. 
a) Data into charts 
b) Charts into data 
c) Chars into results 
d) Results into Charts 
Ans. a 
 
 



These Questions Prepared by: SONU (HEETSON) 
 
145. A single row or a single column of a data is known as _____. 
a) Data series 
b) Data record 
c) Data legend 
d) Single value 
Ans. a 
 
146. To start creating new presentation from already saved presentation, select ________. 
a) Existing presentation 
b) Blank presentation 
c) Design template 
d) Existing presentation and Blank presentation both 
Ans. a 
 
147. The extension of Microsoft powerpoint presentation file is _____. 
a) .ppt 
b) .pdf 
c) .doc 
d) .xls 
Ans. a 
 
148. To go to the previous slide press ______. 
a) Up arrow 
b) Down arrow 
c) Right arrow 
d) Enter key 
Ans. a 
 
149. To begin the slide show presentation, press ______. 
a) F5 
b) F10 
c) F11 
d) Ctrl + S 
Ans. a 
 
150. Most of the wired network connections use ______. 
a) Optical Fibre Cable 
b) USB Cable 
c) Pen drive 
d) Hard drive 
Ans. a 
 
151. When 2 devices are connected through a dedicated line, it is _____ topology. 
a) point to point  
b) Bus 
c) Star 
d) ring 
Ans. a 
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152. The intermediary host which communicates with the clients on behalf of a another server is called 
______. 
a) proxy server 
b) Ethernet 
c) firewall 
d) WiFi 
Ans. a 
 
153. The device used to transfer data from one network to another network on the Internet is called. 
a) Router 
b) Switch 
c) Hub 
d) MODEM 
Ans. a 
 
154. Port No. _____ is reserved for telnet protocol. 
a) 7 
b) 13 
c) 20 
d) 23 
Ans. d 
 
155. Connecting several computers and devices using wired or wireless technology is called _____. 
a) Networking 
b) Ram 
c) Hard disk 
d) Pen drive 
Ans. a 
 
156. WiFi stands for ____. 
a) Wireless Fidelity 
b) Wired Fidelity 
c) Wireless Field 
d) Wired field 
Ans. a 
 
157. Computers and devices can be connected using ______ technology to create a network. 
a) Wired 
b) Wireless 
c) both wired and wireless 
d) Gateway 
Ans. c 
 
158. MODEM stands for _____. 
a) MODulation DEModulation 
b) MODem 
c) MODerate DEModulation 
d) MODulation DEMocracy 
Ans. a 
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159. A network connection requires _______ important components to connect to each other. 
a) IP address 
b) Port Number 
c) Both IP address and Port Number 
d) Lan 
Ans. c 
 
160. A program which runs in the background and sends results requested by a client is called a _____. 
a) server 
b) Ethernet 
c) Firewall 
d) WiFi 
Ans. a 
 
161. The design adopted for connecting several hosts on a network is called ______. 
a) Topology 
b) Telephony 
c) Wiring 
d) Connection 
Ans. a 
 
162. Firewall can _____. 
a) Deny access to specific sites 
b) Allow access to only white listed sites 
c) Both deny access to specific sites and allow access to only white listed sites 
d) Neither deny access to specific sites nor allow access to only white listed sites 
Ans. c 
 
163. When all nodes are connected to a central hub, then it is  a _____. 
a) Star topology 
b) Bus Topology 
c) Ring Topology 
d) Point to point topology 
Ans. a 
 
164. MODEM is a device used for converting ______. 
a) digital signal to analog 
b) analog signal to digital 
c) Both digital signal to analog and analog signal to digital 
d) Neither digital signal to analog nor analog signal to digital 
Ans. c 
 
165. Firewall can be implemented through _______. 
a) Hardware 
b) Software 
c) Hardware and software both 
d) MODEM 
Ans. c 
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166. The network established using Bluetooth technology is called a _____. 
a) Personal Area Network (PAN) 
b) Local Area Network (LAN) 
c) Wide Area Network (WAN) 
d) Metropolitan Area Network (MAN) 
Ans. a 
 
167. The first layer of the OSI model is ______ layer and it controls transmission of bits of data. 
a) physical 
b) data link 
c) network 
d) transport 
Ans. a 
 
168. TCP stands for ______. 
a) Transmission Control Protocol 
b) Transmission Control Procedure 
c) Transit Control Protocol 
d) Transmission Convergence Protocol 
Ans. a 
 
169. The second part of email address identify as _____ . 
a) name of the email server  
b) name of the mobile phone operator 
c) name of bank 
d) name of individual user 
Ans. a 
 
170. Data transfer rate for LAN is normally _____. 
a) 1- 100 mbps 
b) 1-10 mbps 
c) 1-2 mbps 
d) 10-20 mbps 
Ans. a 
 
171. Which of the following is not a windows e-mail programs? 
a) Power Point 
b) Outlook 
c) Pegasus 
d) Eudora 
Ans. a 
 
172. Which device is used for modulation and demodulation? 
a) Modem 
b) Module 
c) Demodule 
d) Adapter 
Ans. a 
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173. What is the full form of NFS? 
a) Network file system 
b) Network folder system 
c) National folder system 
d) National fie system 
Ans. a 
 
174. What is the full form of ATM? 
a) Automated teller machines 
b) Any time money 
c) All time money 
d) Automated timer machines 
Ans. a 
 
175. Which of the following operating system is better for implementing a Client-Server network? 
a) Windows 95 
b) Windows 96 
c) Windows 97 
d) Windows 3.1 
Ans. a 
 
176. Which of the following windows do not have start button? 
a) Windows 8 
b) Windows 7 
c) Windows vista 
d) Windows XP 
Ans. a 
 
177. How to reboot windows operating system? 
a) Ctrl + Alt + del 
b) ctrl + del 
c) Ctrl + alt + shift 
d) ctrl + alt 
Ans. a 
 
178. How to delete program/files permanently in windows operating system? 
a) shift + del 
b) shift + ctrl  
c) shift + alt 
d) shift + enter 
Ans. a 
 
179. Operating system uses a special software called _____ to initialize, operate and control hardware. 
a) Conductor 
b) Ethernet 
c) Driver 
d) SMPS 
Ans. c 
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180. The shortcut visible on the Desktop of windows are called _____. 
a) clipboard 
b) desktop icons 
c) download icons 
d) document icons 
Ans. b 
 
181. _____ command displays volume label of given drive. 
a) VER 
b) DIR 
c) CLS 
d) VOL 
Ans. d 
 
182. _____ Linux command creates a new directory. 
a) Is 
b) chmod 
c) mkdir 
d) rmdir 
Ans. c 
 
183. _____ MS DOS command compares two files and reports any differences. 
a) CHKDSK 
b) BACKUP 
c) COMMAND.COM 
d) COMP 
Ans. d 
 
184. “ITALIC” is an example of _______. 
a) Typestyle 
b) Typeface 
c) Typesize 
d) Typecolour 
Ans. a 
 
185. FAT stands for:- 
a) File allocation table 
b) File access table 
c) File activity table 
d) File accommodation table 
Ans. a 
 
186. How will you capture an active window? 
a) Alt + PrtScn 
b) Alt + P 
c) Ctrl + C 
d) Ctrl + A 
Ans. a 
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187. Adding a program to the taskbar is referred as:- 
a) Pinning 
b) Adding 
c) Fixing 
d) Joining 
Ans. a 
 
188. “BOLD” is an example of ______. 
a) Typestyle 
b) Typeface 
c) Typesize 
d) Typecolour 
Ans. a 
 
189. MS Dos stands for:- 
a) Microsoft disk operating system 
b) Micro Second disk operating syste 
c) Microsoft dirty operating system 
d) Microsoft disk opening system 
Ans. a 
 
190. MS DOS executable files normally have extension. 
a) .EXE 
b) .BAT 
c) .COM 
d) All of these 
Ans. a 
 
191. To clear screen contents, ______ command is used. 
a) CLS 
b) VER 
c) DIR 
d) VOL 
Ans. a 
 
192. Which of command displays the list of files and directories. 
a) DIR 
b) VER 
c) CLS 
d) VOL 
Ans. a 
 
193. _______ Linux command creates a new directory. 
a) mkdir 
b) chmod 
c) rmdir 
d) Is 
Ans. a 
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194. ______ Linux command removes given directory. 
a) rmdir 
b) IS 
c) mkdir 
d) chmod 
Ans. a 
 
195. _____ Linux command changes the access mode of a file. 
a) chmod 
b) rmdir 
c) IS 
d) mkdir 
Ans. a 
 
196. Javascript and VBScript are examples of _____ based scripting languages. 
a) browser 
b) compiler 
c) MS office 
d) interpreter 
Ans. a 
 
197. Human readable program is called ______. 
a) Source code 
b) human code 
c) key code 
d) machine code 
Ans. a 
 
198. A compiler converts surce code to _____ code. 
a) executable machine code 
b) source code 
c) mnemonic code 
d) key code 
Ans. a 
 
199. The rules to be followed in writing source code are called _____ of a programming language. 
a) Syntax 
b) law 
c) syntax error 
d) bugs 
Ans. a 
 
200. The special program which executes source code one line (or few lines) at a time is called ____. 
a) Interpreter 
b) Linker 
c) Loader 
d) Compiler 
Ans. a 
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201. Which of the following programming can be done by Javascript? 
a) game development 
b) desktop application & mobile apps 
c) client side browser 
d) All of these 
Ans. d 
 
202. Javascript language is identified by the parameter language ______ . 
a) “Javascript” 
b) “vbscript” 
c) “vba” 
d) “java” 
Ans. a 
 
203. ______ event is gets activated when a component is clicked. 
a) onclick 
b) onfocus 
c) onblur  
d) onerror 
Ans. a 
 
204. _____ event gets activated when a key moves down. 
a) onkeydown 
b) onkeyup 
c) onkeypress 
d) onmouseover 
Ans. a 
 
205. ______ is the Javascript data type to handle numbers. 
a) Number 
b) String 
c) Boolean 
d) null 
Ans. a 
 
206. ______ is the Javascript data type to handle objects. 
a) Object 
b) Number 
c) Boolean 
d) null 
Ans. a 
 
207. Which statement is used to exit a loop early? 
a) Break 
b) Continue 
c) Exit 
d) Delete 
Ans. a 
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208. Which function is used to retrieve data from a cookie? 
a) ReadCookie 
b) RetrieveCookie 
c) GetCookie 
d) FindCookie 
Ans. a 
 
209. In which year vb 6.0 version was launched? 
a) 1991 
b) 1994 
c) 1996 
d) 1998 
Ans. a 
 
210. The first procedure-oriented language was _____. 
a) FORTRAN 
b) BASIC 
c) COBOL 
d) ADA 
Ans. a 
 
210. Which one of the following is not an integer data type? 
a) Single 
b) Byte 
c) Short 
d) Integer 
Ans. a 
 
211. What is the standard prefix for a menu item? 
a) mnu. 
b) men. 
c) meu. 
d) mni. 
Ans. a 
 
212. An image is made of small dots called ____. 
a) pixel 
b) dot 
c) point 
d) line 
Ans. a 
 
213. In MS Word, format painter may be accessed using the shortcut ______. 
a) Alt + H + FP 
b) Alt + H + X 
c) Alt + H + C 
d) Alt + H + V 
Ans. a 
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214. _____ is the shortcut to create envelops using mailings menu in MS word. 
a) Alt + M + E 
b) Alt + M + L 
c) Alt + M + S 
d) Alt + M + R 
Ans. a 
 
215. After opening a new document in MS Word, what should do to create a comfortable experience? 
a) Set paper size 
b) Set font size 
c) Set paragraph spacing, line spacing 
d) All of these 
Ans. d 
 
216. In MS Office, _____ is the software for preparation of letters. 
a) MS Excel 
b) MS Access 
c) MS Word 
d) MS Powerpoint 
Ans. c 
 
217. In MS Office, _____ is the software for preparation of documents. 
a) MS Word 
b) MS Excel 
c) MS Powerpoint 
d) MS Access 
Ans. a 
 
218. In MS Office ____ is the software for preparation of spreadsheets. 
a) MS Excel 
b) MS Access 
c) Ms Word 
d) MS power point 
Ans. a 
 
219. In MS Word, spelling  mistakes are high-lighted by ____. 
a) red underline 
b) bold text 
c) yellow underline 
d) italic text 
Ans. a 
 
220. In MS Office _____ is the software for managing emails. 
a) MS Outlook 
b) MS Access 
c) MS Publisher 
d) MS Onenote 
Ans. a 
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221. The default extension for an MS Word document is _____. 
a) .docx b) .dosx c) .dosc d) .docs 
Ans. a 
 
222. To select Print item in MS office menu, use ____ shortcut. 
a) Ctrl + P 
b) Alt + F + P 
c) Both Ctrl + P and Alt + F + P 
d) Ctrl + S 
Ans. c 
 
223. _____ is the shortcut for Mailing menu in MS Word. 
a) Alt + M 
b) Alt + R 
c) Alt + H 
d) Alt + S 
Ans. a 
 
224. In MS Word, justified alignment of paragraph may be assessed using the shortcut ___. 
a) Ctrl + J 
b) Ctrl + L 
c) Ctrl + E 
d) Ctrl + R 
Ans. a 
 
225. New Ms Word window may be opened using _____ shortcut in MS Word. 
a) Ctrl + N 
b) Ctrl + M 
c) Alt + W + S 
c) Alt + W + B 
Ans. a 
 
1. Sale or purchase of items without physically visiting a shop is called ____. 
a) E-Commerce 
b) Point of sale 
c) Goods and services 
d) Disposal 
 
2. In E-Commerce, COD stands for  
a) Cash on delivery 
b) Commerce on Delivery 
c) Cash on Demand 
d) Cart on Delivery 
 
3. In an E-Commerce platform bargaining is ______. 
a) Not possible 
b) Permitted with certain restrictions 
c) not allowed 
d) permitted  
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4. ______ data type in VBA stores true or false values. 
a) Boolean b) Byte  c) Long  d) Integer 
 
5. IF condition in VBA ends with ______ statement. 
a) End if 
b) ElseIf 
c) Else 
d) Then 
 
6. In credit/debit cards. CVV stands for ______. 
a) Card Verification value 
b) Card Validity Value 
c) Credit Verification Visual 
d) Credit Verification Value 
 
7. Currency data type in VBA has size of ______. 
a) 8 bytes 
b) 2 bytes 
c) 3 bytes 
d) 4 bytes 
 
8. In taxation, TDS stands for ____. 
a) Tax deviation at source 
b) Tax Deducted at station 
c) Tax Deducted at Source 
d) Tariff Deduction at source 
 
9. Tally is a _____ software. 
a) Accounting 
b) Spreadsheet 
c) Publishing 
d) animation 
 
10. _____ can fix so many problems in computer. 
a) rebooting 
b) selling off 
c) condemning 
d) cursing 
 
11. Excel file without any macros has the default extension of _____. 
a) .xlsx 
b) .xlsm 
c) .xls 
d) .xlst 
 
12. By default, Excel worksheets are named as _____. 
a) sheet1, sheet2, sheet3 
b) page1, page2, page3 
c) note1, note2, note3 
d) book1, book2, book3 
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13. The MS office tool used for preparation of presentation is called _____. 
a) MS Power point 
b) Ms Word 
c) Ms Excel 
d) Ms Access 
 
14. Primary boot process is also called ___. 
a) Loading of operating system 
b) Installation  
c) Formatting 
d) Post 
 
15. EPROM stands for:- 
a) Erasable Programmable Read Only Memory 
b) Erasable Partition Read Only Memory 
c) Erasable Pointer Read Only 
d) Extended Programmable Read Only Memory 
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